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1 Introduction

ENCHECK is a software package designed to assist with the identification
of environmental effects of irrigation, drainage and flood control works.

It follows the guidelines provided by the International Commission on
Irrigation and Drainage (ICID). These ICID guidelines are published in "The
ICID Environmental Check-list" by HR Wallingford Ltd (August 1993) on
behalf of the ICID.

ENCHECK can be thought of as an organiser and offers the following:

1. Repository for information connected with the study.

2. Collating system with various views on the information stored.

3. Indicators showing the progress of the study.

4. Easy transfer of information to printer, ASCII file or word
processor.

5. Bibliography of relevant references, both English and French.

ENCHECK is a Windows 3.1 application and should run on any PC with
DOS and Windows 3.1 or Windows 4 installed. Hard Disk requirements are
modest at around 1Mb for program files and less than 0.5Mb for a typical
project data file. The help facility includes the complete ICID Checklist
publication on line together with additional information relating to the
software.

2 Installation of ENCHECK

Approximately 1Mb of free hard disk space is needed for the installation.

ENCHECK is supplied on a single floppy disk and includes its own setup
program. The following steps are necessary to install ENCHECK.

1. Start Windows from the DOS prompt (it is recommended that
installation should take place on a freshly loaded Windows.)

2. Insert the ENCHECK program, disc into drive A: (or B:).

3. Select "Run” from the "File" menu of Program Manager.

4. Type "a:setup.exe” in the "Command Line" (use b:setup.exe if

the floppy drive is B:). (Avoid using the "Browse" push button).

5. Press "OK" push button.
6. Enter the name of the directory where ENCHECK program files
are to be placed (the default is C\ENCHECK).
7. Press the "Continue” push button to complete the installation.
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The install program will create a new program group nhamed ENCHECK
with the Windows Program Manager and adds two items to this group. The
icon for loading ENCHECK, plus an icon for loading the help file.

If you encounter problems with the installation refer to the section of this
manual called Problems with installing ENCHECK.

It is recommend that the ENCHECK project datafiles are kept in a separate
directory to the program files. During the installation, ENCHECK creates a
sub directory called "PROJECTS". The command line switches shown
below are also added, to inform ENCHECK that the working directory is
ENCHECK\PROJECT, and the location of the original files.

There are two optional command line switches recognised by ENCHECK
when starting from either Windows or DOS. These switches may appear in
any order:

1. /dir directory_name. Where directory_name is the location of the
ENCHECK ancillary program files (original.enc and encheck.hlp), this
usually would be CAENCHECK.

2. file_name. Where file_name is the name of the ENCHECK datafile
to be loaded when ENCHECK starts.

Note: ENCHECK must always have access to ORIGINAL.ENC which
contains the information necessary to start a new project, the original ICID
links between questions and topics. Access to ENCHECK.HLP is required
when help is requested. It is therefore recommended that the /dir switch
described above is always used. For information on adding either of these
switches see the How To section of the ENCHECK help file.

3 Running ENCHECK

Although ENCHECK requires Windows to run it can be started from either
Windows or DOS.

From Windows double click on the ENCHECK icon in the Program
Manager.

From DOS change to the ENCHECK program directory and type
"ENCHECK", plus any command line switches.

ENCHECK will now load, if it is the first time it has been started it will
require registration information to be entered.

ENCHECK automatically loads a datafile called project.enc, unless another
datafile is specified by the command line switched, (see above). Use the
"File" menu, and "Save As" command to save the datafile with a different
name.
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4 Problems with installing ENCHECK

There are occasions when ENCHECK is not able to install first time
because other software is using a file called COMMDLG.DLL. This file
needs to be used by ENCHECK, but it will not install if it is being used by
another application during installation.

If this problem does occur, then follow the instructions below.

1. Exit Windows, and type "CD WINDOWS\SYSTEM", press return.

2. Type "DIR COMMDLG.DLL", press return. The date of this file
should be prior to 1/11/93, if the file is newer than 1/11/93 then
goto step 7.

3. Type "XCOPY COMMDLG.DLL COMMDLG.001", press return.

4. Type "DEL COMMDLG.DLL", press return.

5. Type "WIN/3 A:\SETUP.EXE", press return with the ENCHECK

installation disk in drive A, if it is drive B, then replace the letter
A with B. Windows will now load, more than likely there will be
warning messages will appear on the screen, saying that a
particular application can not be run. DO NOT BE ALARMED,
they will work after ENCHECK has been installed.

6. The ENCHECK installation program should start automatically,
from here on follow the instruction given in section 2. When you
next start Windows, your other software should run again. If they
do not work, then exit Windows and type the following
commands.

Type "CD WINDOWS\SYSTEM", press return.
Type "XCOPY COMMDLG.001 COMMDLG.DLL, press return.

This will copy the original COMMDLG.DLL before the ENCHECK
installation program was tried. Your applications will now work again.
ENCHECK may not load now, if this is the case contact the Overseas
Development Unit at HR Wallingford for more help.

7. If the COMMDLG.DLL file is newer than 1/11/93, then there
should not be a problem with ENCHECK installation program. If
you experience a problem then contact the Overseas
Development Unit at HR Wallingford for more help.
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5 General Information

Context sensitive help is available within ENCHECK by pressing the F1 key
at any point. Also access to help information can be obtained by selecting
"Contents" or "How To" from the "Help" menu. See section 6 for more
information on the "Help" facility.

Each project assessment is stored in an ENCHECK project file (datafile).
The file contains all information connected with a project including
guestions, topics, references and links between questions and topics. The
default file name extension is .ENC. The file ORIGINAL.ENC contains the
information necessary to start a new project and cannot be overwritten
from within ENCHECK.

Questions, topics and references all have "views". Within ENCHECK views
are selection criteria which enable a subset of items to be viewed in
isolation. For example it is possible to view only "Unassessed" questions or
references relating only to the current topic. The default for all three views
is to see all items. Question and topic views are changed on the toolbar.
The reference view is changed within in the reference window.

ENCHECK includes a bookmark facility, the bookmark is saved as part of
the project file. Therefore it is possible to set the bookmark, save the file,
quit ENCHECK and then re-start ENCHECK and goto the position of the
set bookmark. The bookmark is controlled via the commands listed under
Bookmark in the Edit menu.

Although ENCHECK provides facilities for organising text, it does not
provide full word processing capabilities. If report standard output is
required a word processor is needed. This can be as simple as Write, the
standard Windows word processor, or any other 3rd party Windows or
DOS word processor. Text can be transferred from ENCHECK to the word
processor in two ways:

1. Via the Windows Clipboard (the most convenient for a small
number of items of text). Not available for DOS word
processors.

2. Via an ASCII text file (the most convenient for a large number of

items of text).
For more information on these methods see the ENCHECK help file.

It is necessary to distinguish between the two types of text entry field used
by ENCHECK:

1. A standard word wrap field with no horizontal scroll bar. For
example the Topics Window and the References Remarks field. Text
entered here automatically wraps to the next line when required. In order to
reduce the amount of re-formatting required after transfer to a word
processor it is recommended that a carriage return (ie the "Enter" key)
only be used to end a paragraph.
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2. A fixed pitch font field with a horizontal scroll bar. For example the
Questions Window and the Cover Sheet window. Lines entered here
must always be terminated by a carriage return. This type of window is
used by ENCHECK when word wrap would destroy positional formatting.
When this text is imported into a word processor, either a fixed pitch font (ie
a non proportional font) should be used or the text alignment features of
the word processor used to regain positional format.

Individual questions, topics and references can be "Tagged". Tagging
provides an additional way of selecting items for printing or transferring to
file. (Other print selection methods are the current item or items in the
current view). Items can be tagged/untagged individually on their
respective windows, or global tagging/untagging is possible via the "Tag"
item of the "Edit" menu.

There is a 64K limit on the amount of text that can be stored by ENCHECK
as the answer to a question, topic, reference remark or report text. In
practice this is about 12 - 16 pages.

ENCHECK project files are structured in a certain way and must not be
edited other than by using ENCHECK.

The ENCHECK tool bar that appears beneath the menu bar of the
ENCHECK main window is described below.

The "Questions view" drop down list box determines the current view of
the Questions. By default all questions are available; options selectable
from this list box, control the questions that you wish to make visible. For
detailed information see the ENCHECK help file.

The "Topics view" drop down list box determines the current view of the
Topics. By default all topics are available; options selectable from this list
box control the topics that you wish to make visible. For more detailed
information see the section in the ENCHECK help file.

The information to the right of the "Topics view" drop down list box shows
the current question, current topic and the link between the two.

Note that it is not possible to have the view of questions as "Topic related"
and at the same time have the view of topics as "Question related".

An "Unsaved edits" indicator is located to the left of the "Questions view"
drop down list box which becomes visible (red square) when an edit or a
change to the project has taken place. Saving the project file writes the
revised project to disk and removes the indicator.
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6 ENCHECK Windows and Commands

ENCHECK incorporates a comprehensive help file which includes
information on all the ENCHECK Windows and Menu Commands.
Guidance on how to carry out operations is also available in the How To
section of the help file. Access to the Help file is either from the "Contents"
or "How To" commands in the "Help" menu, by pressing "F1" key, or
double clicking on the ENCHECK help file icon in Program Manager. To
aid the user, access to the How To topics can be via a standard index or
selecting on graphical images of the ENCHECK windows and menus.

6.1 Project Window.

The project window allows the name of the project to be defined or
changed and progress of the assessment monitored.

The following check boxes appear in the "Progress” group box:

Cover sheet Questions
References Topics
Report

These may be checked by the user when that particular part of the
assessment is complete. Also there is an indicator of how the study is
progressing. Information about the state of questions, references or topics
can be displayed as a guide to updating the check boxes or as general
information.

6.2 Cover Sheet Window.

This window initially contains the project assessment cover sheet
contained in the Checklist book. Details about the project and its
assessment may be entered in this window at the appropriate location.

A fixed font is used in this window to preserve positional formatting. If
imported to a word processor, some editing may be required to regain the
original layout if a proportional font is used.

6.3 Report Window.

The lower part of the report window contains suggested headings for the
report on the identified environmental effects.

The text of the report may be entered at the appropriate locations in the
window. A carriage return (ie the "Enter" key) should only be used to
terminate each paragraph, not each line. Text entered in this way will
import more satisfactorily into a word processor.

The top part of the report window contains a summary of topic assessment.
Negative impacts head this list followed by positive impacts, no impact and
finally unassessed topics. This information is updated each time a topic’s
assessment is changed.
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6.4 Notepad Window.

The notepad window can be used to store items of text which do not fit into
the categories provided, or as a clipboard to store text, notes, address etc.

The ENCHECK notepad forms part of the project and its contents are
stored in the project file.

A carriage return (ie the "Enter” key) should only be used to terminate each
paragraph, not each line. Text entered in this way will import more
satisfactorily into a word processor.

6.5 Questions Window.

The questions window shows the current question and its assessment. The
current question is changed by pressing the "Next" or "Previous” push
buttons or by selecting the question directly from the "Question" menu.
Only the questions in the current view can be displayed.

The answers to the questions should be typed directly into the questions
window. A carriage return (ie the "Enter" key) is used to terminate each line
to the answer.

After each question is answered it may be assessed using the drop down
list box titled "Assessment". Assessment Rating 1 to 3 is aimed for the
user to reflect on the quality of data, and is not an "impact rating".

Individual questions can be tagged/untagged using the "Tagged" check
box.

6.6 Topics Window.

The topics window shows the current topic and its assessment. The current
topic is changed by pressing the "Next" or "Previous" push buttons or by
selecting the topic directly from the "Topic" menu. Only the topics in the
current view can be displayed.

The findings on each topic should be typed directly into the topics window.
A carriage return (ie the "Enter” key) should only be used to terminate each
paragraph, not each line. Text entered in this way will import more
satisfactorily in a word processor.

After each topic is described it may be assessed using the drop down list
box titled "Assessment". This is an "impact likelihood" assessment not an
"impact importance" assessment. This assessment will be used by the
assessor to identify "key issues", with regard to Environmental Impact
Assessment. This section is the main part of ENCHECK and the Check-list,
refer to the Check-list or ENCHECK help file for more guidance on
assessing topics and identifying "Key Issues".

Individual topics can be tagged/untagged using the "Tagged" check box.
As well as questions being linked to topics, there are topics which are

relevant to other topics. Links between these are displayed in the relevant
Topics Window.
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6.7  Question Ranking Window.

Each question can be linked to a number of topics. Each relationship has
one of three levels of connection. Consequently some questions have a
greater input into the findings of topics than others.

This window provides some guidance to the relative input of each question
to the topics and is based on the number and level of links to topics. This
information can be used to aid the assessor in collecting data. It should be
noted that this is intended to be an aid and not a definitive selection
process.

For each question a weak link is awarded one point, a moderate link 2
points and a strong link 3 points. The sum of these links is then used to
rank questions in order of the highest score.

This link factor and the ranked order of questions are shown in this window.

If a link between a question and topic is changed, or the current question
assessment is changed the information in this window is updated
automatically.

6.8 Calculator Window.

Although the calculator provided with ENCHECK is simpler than both the
standard and scientific Windows calculators, it has the advantage of being
smaller and remains on top of the ENCHECK main window.

The "Copy" push button on the calculator copies the displayed result of
any calculation into the Windows clipboard. The number can then be
pasted into the text using the "Edit", "Paste" menu options.

6.9 References Window.

The standard set of ICID references are displayed in this window together
with additional references applicable to the project. ENCHECK includes
both English and French references, an option is given to display both or
either sets of references.

Four views of references are provided:

1. All references

2. References relating to the current topic only. Note: a single
reference may relate to more than one topic.

3. General references as defined by ICID.

4, Additional references defined by the user and applicable to the

current project.

Only additional references can be added or deleted. The additional
references can be sorted either by year of publication or author.

A text box ("Remarks") is provided with each reference to enable
comments to be stored.
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6.10 File Menu Commands.

New

A new project file is created based on the information in the file
ORIGINAL.ENC. The default file name provided when this option is
selected is UNTITLED.ENC. Use the "Save As" option described below to
save the project with a different name.

Open

The file open dialogue box is displayed. Use this dialogue box to select an
ENCHECK project file to load. ENCHECK project files have the extension
.ENC by default. The only type of file that can be loaded is an ENCHECK
project file.

The file ORIGINAL.ENC has a special purpose in that it contains original
guestions, topics, references and linkages. Although this file may be
loaded, ENCHECK will not overwrite it when a save is requested.

Save
Saves the current project file. This option is grey when there are no
outstanding edits to save.

An "Unsaved edits" indicator (red square) is located to the left of the
"Questions view" list box which becomes visible when an edit or a
change to the file has taken place. Saving the project file writes the revised
project to disk and removes the indicator.

Save As
The Save As dialogue box is displayed. This allows the current project file
to be saved with a different name.

It is not possible to save as ORIGINAL.ENC since this contains the
information necessary to start a new project.

Page Setup..
Allows the user to specify the size of the margins around the printed page.
The setting is performed by moving the scroll bar for each margin.

Print
This gives access to a menu for the selection of information to be printed.
This is explained in the section Print Menu Commands.

Exit

This closes the ENCHECK window, if the current datafile has unsaved
information on display, it will ask you whether the datafile should be saved.
To keep this new data from the last "Save" or "Save as" command select
"Yes".

6.11 Edit Menu Commands.

Cut
Removes the selected text from the text field and places it in the Windows
clipboard. This option is grey when there is no item selected.

Copy

Copies the selected text to the Windows clipboard. This option is grey
when there is no item selected.
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Paste
Copies the contents of the clipboard into the text field at the position of the
cursor. This option is grey when there is no text in the clipboard.

Delete
Deletes the selected text. This option is grey when there is no text to
delete.

Select all
Selects all the text in the current text field. This option is grey when the
current control is not a text field.

Tag
Individual questions, topics and references can be "Tagged". Tagging
provides an additional way of selecting items for printing or transferring to
file.

This command leads to additional options which control the global
tagging/untagging of questions, topics and references. ltems can also be
tagged/untagged individually on their respective windows,

The "Clear all" options remove all tags associated with the information
type.

The "Tag all" menu options tags all items whether or not they are in the
view.

The "Tag view" options only tags items which are in the current view.

Bookmark
This command leads to three additional options which control the
bookmark.

"GoTo" changes the current question, topic, reference view, topic view and
reference view to that of the bookmark.

"Set" sets the bookmark to the current question, topic, reference view, topic
view and reference view.

"Clear” removes the bookmark.
If "GoTo" and "Clear" are grey this indicates that the bookmark is not set.

The bookmark is saved as part of the project file. Therefore it is possible to
set the bookmark, save the file, quit ENCHECK and then re-start
ENCHECK, by selecting "Bookmark"” and "GoTo" in Edit menu
ENCHECK will return to settings that you left when exiting, but not the
location of ENCHECK windows.

Link

This command displays a dialogue box which allows the link between the
current question and current topic to be changed. This is dimmed when
there is neither no current question nor no current topic.

-10 -
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The link window allows:

1. The link between the current question and current topic to be
changed. This is done by changing the value in the drop down list
box titled "Link".

2. All guestion/topic links can be reset to their default ICID values
(as stored in the file ORIGINAL.ENC). This is done by pressing
the "Reset all" push button.

Note the warning on this window that changing a link is contrary to ICID
recommendations.

6.12 Question Menu Commands.
This menu lists all of the questions for use with the Check-List.
They are listed in number order, within their categories.

Those questions which have been "assessed" have a tick placed next to
them.

Questions which are not within the current Question View are dimmed out,
these are not accessible.

To select a question, either use the keyboard or mouse to highlight it, then
hit "Enter" or Press the left mouse button.

Note the question will not be displayed unless the Question Window is
open on screen.

6.13 Topic Menu Commands.

This menu lists all of the topics for use with the Check-List.

They are listed in number order, within their categories.

Those topics which have been "assessed" have a tick placed next to them.

Topics which are not within the current Topic View are dimmed out, these
are not accessible.

To select a question, either use the keyboard or mouse to highlight it, then
hit Enter or Press the left mouse button.

Note the question will not be displayed unless the Topic Window is open on
screen.
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6.14 Windows Menu Commands.

Cascade

This places the open windows within ENCHECK one behind each other,
such that their title bars are visible. The current window is displayed at the
front of the cascade.

Tile Horizontally
This tiles the open windows with ENCHECK horizontally, such that they are
displayed with equal size across the ENCHECK window.

Tile Vertically
This tiles the open windows with ENCHECK vertically, such that they are
displayed with equal size vertical within the ENCHECK window.

Arrange Icons
This brings the icons of the closed ENCHECK windows into a line at the
bottom of the ENCHECK window.

Project Opens the Project window.

Question Opens the Question window.

Topic Opens the Topic window.
Coversheet Opens the Coversheet window.
Report Opens the Report window.
References Opens the References window.
Question Ranking Opens the Question Ranking window.
Notepad Opens the Notepad window.
Calculator Opens the calculator window.

6.15 Help Menu Commands.

Contents
This displays the main Table of Contents of the ENCHECK help file.

How To

This displays the graphical How To menu. Using the mouse select on the
Menu, Window or area of the screen on which you require information on.
When selecting on a menu, the menu is displayed then select on the
required command.

How to Use Help
This displays the Windows Help file on how to use them.

About ENCHECK
This displays the registration details of ENCHECK, and information about
the present system resources of the computer.

-12 -
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6.16 Printing Menu Commands

The print file dialogue box enables topics, questions, references, the cover
sheet, the report and the ICID result sheet to be printed or transferred to an
ASCII text file.

The "Print items" group box contains radio buttons which determine the
type of information to be printed. When a button is grey this indicates there
is currently nothing to print form that selection. The number of items that
will be printed appears in the title of the radio button.

The "Printer font" dialogue box contains information and controls relating
to the font that will be used when printing. This has no effect when writing
to an ASCI| text file.

The "Change" push button displays a dialogue box containing fonts that
can be supported on the default Windows printer. If a fixed pitch (ie non
proportional) font is required the "Show fixed fonts only" check box
should be marked before selecting "Change". In this case only fixed pitch
printer fonts will be shown. Fixed pitch fonts may be necessary when
printing questions and the cover sheet to preserve positional formatting.

The "Each item on a new page" check box determines whether each item
printed will start on a new page or run on continuously from the previous
item. If an ASCII text file is produced this inserts a form feed character
between each item if checked.

The "OK" push button displays a dialogue box showing the default printer.
The only effective controls on this dialogue are the "Printer resolution”
drop down list box, the "Setup" push button, the "OK", "Cancel" and
"Help" push buttons and the "Print to file" check box.

If the "Print to file" check box is not marked, output is sent directly to the
printer. If the check box is marked a further dialogue box is displayed which
enables the name of the ASCII output text file to be specified.

-13-
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6.17 Question View.

The "Questions view" drop down list box determines the current view of
the questions.

By default all questions are available; options selectable from this list box
control the questions that are visible.

Note that it is not possible to have the view of questions as "Topic related"
and at the same time have the view of topics as "Question related".

Depending on the current view, automatic updating of the question view
when a rating has changed could lead the a disconcerting disappearance
of the question as the question’s rating is changed.

The "View invalid" push button immediately above the "Questions view"
list box is normally grey and unavailable (it is marked with a cross).
However if the current view of questions is not "All questions" or "Topic
related” and an assessment of a question is changed, this button becomes
active (changing in colour from grey to black cross).

This indicates that the current view of the questions may be invalid
because of the question re-assessment. Pressing the "View invalid" push
button ensures that the view is brought upto date.

For example if the question view was "Rating 1", the question currently
displayed would be a Rating 1 question. If the question's assessment was
changed to Rating 2, the "View invalid" would change from grey to black
and become active because a Rating 2 question was now on display in a
"Rating 1" view. Pressing the "View invalid" push button would remove the
question from the current view.

6.18 Topic View.

The "Topics view" drop down list box determines the current view of the
topics.

By default all questions are available; options selectable from this list box
control the questions that are visible.

The views of topics are:

All topics Unassessed

+ve impacts (A,B) -ve impacts (D,E)
No change (C) More data (F)
Expert help (F) Not understood (F)
Not applicable (F) Question related

Note that it is not possible to have the view of questions as "Topic related"
and at the same time have the view of topics as "Question related".

The "View Invalid" push button works in the same way as the Question
View "View Invalid" button, but for updating the topic view. See the
Question view section of the manual for information on this button.
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7 Error and Warning Messages

The following non fatal warning messages are produced by ENCHECK:

[W1] Unable to open datafile:

The project datafile specified cannot be opened. The project datafile
currently displayed remains. Possible cause: invalid file name or file in use
by another application.

[W2] Error reading file:
The file specified was found but an error occurred during the read. Possible
cause: opening a non ENCHECK file or corrupted ENCHECK file.

[W3] Cannot view questions as topic related and topics as question
related at the same time

The question view "Topic related" and the topic view "Question related”
cannot be selected at the same time because this combination is
ambiguous. In this case the view is reset to "All".

The following error messages are produced by ENCHECK which terminate
the current operation:

[E1] Unable to open datafile:

The project datafile specified cannot be opened. ENCHECK terminates
because there is no project file loaded. Possible cause: invalid data file
name or file in use by another application.

[E2] Error reading file:

The file specified was found but an error occurred during the read.
ENCHECK terminates because there is no project file loaded. Possible
cause: opening a non ENCHECK file or corrupted ENCHECK file.

[E3] Error writing file:
The file save operation failed. Possible cause: invalid file name, file is write
protected or there is insufficient disc space

[E4] Cannot overwrite the original datafile

The file ORIGINAL.ENC has a special meaning to ENCHECK since it
contains the original ICID question, topics, references and linkages. It is not
possible to save to a file with this name.

[E5] Error printing:

An error occurred while printing. Possible cause: printer fault, invalid file or
insufficient disc space if writing to file.

[E6] Registration details not completed
Registration details require both the "Name" and "Company details" to be
supplied.
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8 Contacting HR Wallingford

If you experience a serious problem with the ENCHECK software, either
during installation or during its operation and you require assistance please
contact the International Development Group of HR Wallingford Ltd.

Before you contact us, if possible follow the steps listed below:

1. Read the description of any error messages displayed. (Note: the
descriptions of ENCHECK error messages are in the ENCHECK manual or
within the "How To" section of the ENCHECK help file.)

2. See whether you can repeat the problem occurring, write down the
sequence of commands that you carried out.

3. If the problem is during the use of ENCHECK datafile, save the
existing one and create a new one, then see if you can repeat the problem
occurring.

By carrying out these steps it will aid the identification and solving of the
cause of your problem.

Given below is our address, telephone and facsimile numbers. When
contacting can please clearly mark the letter or facsimile ENCHECK
software.

International Development Group
HR Wallingford Ltd

Howbery Park

Wallingford

OXON

GREAT BRITAIN

0OX10 8BA

HR Telephone Number (UK): 01491 835381.
HR Telephone Number (International): + 44 1491 835381.

Facsimile Number (UK): 01491 826352.
Facsimile Number (International): + 44 1491 826352.
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Notes

Use this for your own notes on ENCHECK.
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